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Introduction 
 
PowerPoint is a presentation program that is included in Microsoft’s Office suite of programs.  
Since its introduction in 1990, PowerPoint has become the most prevalent presentation program 
on the market.  Today, PowerPoint presentations are used in just about every area of modern 
society including civic clubs, classrooms, business meetings, weddings, churches, and even 
funerals.   
 
The PowerPoint program has a remarkable array of features to enhance a presentation and has 
revolutionized speaker presentations.  Prior to PowerPoint most visual presentations used 
viewgraphs (overhead projector slides), 35mm slides, or flip charts.  The ease with which a 
presentation can be put together using PowerPoint is amazing.  However there is a downside to 
PowerPoint – which is poorly done presentations. 
 
PowerPoint has made it easy to put together presentations, but that doesn’t mean the end result is 
a good presentation.  Anyone who has sat through a 100-slide PowerPoint presentation that 
featured an endless number of bulleted points or paragraphs along with fancy transitions will 
understand the downside of PowerPoint.   
 
The purpose of this course is to provide some guidance on how to use PowerPoint more 
effectively in presentations.  This is not a “how to” course on how use the features of 
PowerPoint, although a few specific features are explained, but it is a course on how to use the 
features of PowerPoint to the best advantage.  This course assumes that the user has a basic 
mastery of PowerPoint and wants to make better use of the features of the program.   
 
The course is based on the opinions of the author, who has made hundreds of presentations, 
many of which have surely induced a deep sleep among at least a few participants! 
 
In this course, we will review a few of the common problems found in many PowerPoint 
presentations and how to use the rich features of PowerPoint as an aid to making presentations 
without allowing the features to distract from the presenters story.  The ultimate goal of this 
course is to help the reader hold the audience’s attention while presenting his story.  The story 
may be presentation to make a business case to upper management, to venture capitalist, or it 
may be to describe a particular topic to a civic club.  Whatever the occasion, the presenter is 
trying to persuade the audience and PowerPoint is a powerful tool to aid in storytelling. 
 
The layout of the course begins with a brief overview of PowerPoint and then looks as how text 
is used in presentations, followed by color, graphics, and animation.  In addition, we will study 
effective slide layouts, use of audio-visual equipment, and how to make the actual presentation 
performance more effective. 
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I. Overview 
 
PowerPoint actually began as a program for the 
Macintosh computer in 1987.  The original 
program offered only black and white and simple 
drawing tools and was designed by a company 
known as Forethought.  Shortly after Forethought 
released its first version of PowerPoint (version 
1.0) Microsoft bought the company and acquired 
the rights to PowerPoint.  It wasn’t until 1990 that 
Microsoft released its first Windows compatible 
version of the program.  PowerPoint 2.0 was not 
only compatible with both Windows and 
Macintosh platforms, but it also introduced many 
of what we think of today as standard PowerPoint 
tools such as bullets; drawing fills, and spell 
checking capability.   
 
Although the earliest versions of PowerPoint were marketed as stand-alone programs, since the 
introduction of Microsoft Office 2003, PowerPoint has been an integral part of the Office suite of 
products.  As a component of the Office suite, PowerPoint has inter-operability among the Office 
products allowing ‘cut’ and ‘paste’ operations from Word and Excel as well as other programs. 
 
One of the attractive features of PowerPoint is its ease of use.  It has a simple yet powerful 
interface that allows even novices to quickly produce a presentation.  And there are many 
powerful features that experienced users can exploit to make even better presentations. 
 
The basic functions of PowerPoint allow the user to develop slides with text, color, graphics, 
transitions, and animations.  The term slide is a reference to the old slide projector technology 
that preceded PowerPoint and is still used to describe an individual view in PowerPoint.  In fact, 
you will still find references to a deck of slides, which is a reference to a presentation made from 
viewgraph overhead projector slides. 
 
 
 
 

Note:  The features discussed in this course are based on Microsoft 
PowerPoint 2003, though most features and procedures are the same 
or very similar in other releases of the program. 
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II. Text 
 
Text is the backbone of a PowerPoint presentation so it is important to know how to make the 
best use of text in a presentation.  The most important text issues are the type of font to use, the 
size of the font, and proper grammatical use. 
 
Font Types 
 
Fonts can be categorized as either serif fonts or sans serif.  A serif is a small flair on the ends of 
the letters that make printed words more readable.  Look at the following box which shows both 
a sans serif font, in this case it is Arial, and a serif font, such as Times New Roman.  The Times 
New Roman font has flairs on the tops and each side of the bottom of the legs of the “M”.  If you 
will notice, a sans serif font such as Arial does not have flairs, but instead has straight extensions 
of the legs of the “M”. 
 

 
The 
serifs 
make 
printe
d 
words 
easier 
to 
read, 
but 
can 

make text on computer screens and projected text more difficult to read.  For computer screens 
and projectors, a sans serif font should be used.  Here are a few of the popular sans serif and serif 
fonts, 
 

Font Options 
Sans Serif      Serif 

Arial Times New Roman 
Tahoma Courier 

Verdana      Garamond 
 
Verdana is a popular font for websites and is also a good choice for PowerPoint presentations.  
Serif fonts may be used in PowerPoint, but they should be restricted to titles or very large and 
brief bullet points. 
    
Type Size 
 
Once a font is selected, the next step is to select a font size.  The font must be large enough for 
the text to be readable by everyone in the audience.  Let’s look at a few font sizes.  Fonts are 

Sans Serif vs. Serif 
 

   M     M 
           Sans Serif                        Serif 
                Arial     Times New Roman 
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described in points.  In typography a point is 1/72 of an inch.  Therefore, a 72-point font is one-
inch tall and a 36-point font is ½ inch tall.  However, electronic fonts are affected by the 
resolution of the computer screen, so a 72-point font may not be 1-inch tall on the computer 
display.  Based on the resolution of the screen used in developing this course, a 72-point font is 
about ¾ of an inch tall.  Listed below are a few common point sizes.   
 

 
 
A common question is “how large of a font should I use?”  The answer is the font needs to be big 
enough!  Of course the question then becomes, “how big is ‘big enough’”?  Several methods 
have been suggested to answer this question. 
 
“Five foot” rule 
When designing a presentation on a computer a very simple approach to determine how a 
particular font size will appear in the actual presentation is to just push back from the computer 
screen about five feet and see how it looks.  Just put your foot on the edge of the desk at the 
computer screen and push your chair back by extending your leg.  From this distance a 
PowerPoint slide on a typical screen will look about the same as when projected on a screen in 
an average size meeting room.  Obviously this method is very unscientific and there are plenty of 

Examples of Font Sizes 
 

This is 12-point type 

This is 16-point type 

This is 24-point type 

This is 36-point type 

This is 48-point type 

This is 72-point 
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reasons why it is not sufficient such as different screen sizes, different meeting room sizes, etc, 
but as a general rule of thumb the five-foot rule is a good test. 
 
Room-Screen Ratio 
A more scientific approach to determine a font size is the room-screen ratio test.  To use the 
room-screen ratio test divide the depth of the room by the diagonal projector screen size (in feet).  
The resulting ratio is the minimum font size that should be used.  For instance, if a room is 50 
feet deep and the screen size is 4-feet diagonally, then the smallest font size to use is, 
 
Font = 50 / 4 = 12.5 points. 
 
For a 100 foot room with a 4-foot projection screen, the minimum font size should be 100/4 or 
25 points. 
 
Painter’s Rule 
The “Painter’s Rule” comes from the sign painting profession.  Sign painters say that to be 
readable the text on a sign should be at least one inch tall for every 10 feet from the target 
audience.  Applying this rule to a PowerPoint projection, the projected font should be at least 1” 
tall for every ten feet to the viewer.  So if a last seat in the room is 50 feet from the projection 
screen, the font should appear at least five inches tall on the screen. 
 
The painter’s rule is probably the best method for consistent results.  The problem is that this 
procedure does not define a font size since it is based on what is actually projected onto the 
screen, and even a 12-point font can be large on the screen if the projector is at a sufficient 
distance from the screen.   
 
A combination of the Room-screen ratio approach and the painter’s rule will yield consistently 
good results. 
 
Room Size 
Some presenters use the following simple relationship for minimum font sizes. 
  
 Number of seats  Font Size 
    <50   24-point 
 50 – 200  28-point 
   >200   36-point 
 
This approach assumes that the projector screen size is appropriate for the room and is only a 
rough rule of thumb. 
 
Minimum Font size 
Another consideration is to select a minimum font size.  The minimum font size should be no 
smaller than 24-points, with 28 to 36-points the preferred font size for the body of the slide.  
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While we are talking about minimum font size we should mention the ratio of the title font size 
to the body text font size.  A good relationship is to set the body text font size at about 80% of 
the title font size.  Here are some good title-to-body text size pairs, 
 
 

 
Font Style 
 
The four most popular font styles are regular, bold, italic, and underlined.  A bold style can work 
for titles and the body text provided an appropriate font is selected.  Some fonts are hard to read 
in bold style such as, Extra Bold Albertus.  Likewise, italics can be hard to read on the screen 
and should be used sparingly.  Italics may be used with large clean fonts, but it is generally best 
to avoid italics.  Never use underlined text in a PowerPoint presentation.  Underlines make the 
text very difficult to read and can be mistaken for a website URL. 
 
Grammar 
 
The rules of sentence structure should be somewhat disregarded when using PowerPoint bullet 
points.  When using bullet points, complete, grammatically correct, sentences are difficult to read 
and can be distracting for the audience.  Instead, bullet points should be comprised of short, key 
words for emphasis.  In fact, if a bullet point is a grammatically correct sentence, it is probably 
too long. 
 
Nothing is more distracting than poor spelling and grammar in a PowerPoint presentation.  The 
message of a presentation is easily lost when spelling and grammatical errors are in the 

Title-to-body text size pairs 
 
                            Title Font Size     Body Text Font Size 

                    28-Point          22-Point  

36-Point        28-Point 
 

    44-Point    36-Point 

72-Point  60-Point
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presentation.  Care should be taken when using the spell checker utility.  “There” and “their”, 
“an” and “and”, as well as many other combinations will pass the spell checker utility.  One of 
the best ways to check spelling and grammar is to let the presentation “sit” for a few days before 
the final review and editing.  Looking at the presentation “cold” will give the presenter a fresh 
perspective. 
 
Capitalization also requires special consideration with PowerPoint.  Presentations generally look 
better when title capitalization is only used for 
the title.  The body text should have normal 
capitalization.  See the example on the right.  
The major words in the title are capitalized.  In 
the body though, capitalization follows normal 
capitalization rules.   
 
Titles, sentences, and bullet points should rarely, 
if ever, use all capitals.  There are some cases 
where it is good for emphasis, but generally it is 
considered to be the equivalent of shouting and 
is difficult to read. 
 
Do this, 
 
“This is Good Title Capitalization”, 
 
and not this, 
 
“THIS IS NOT APPROPRIATE TITLE CAPITALIZATION”. 
 
In most cases punctuation is not necessary and may be distracting.  Avoid periods, exclamation 
marks, and question marks.  Remember, if it is a grammatically correct sentence it is too long! 
 
 
 
 
 
 
 
 
 
 
 
 
 



www.PDHcenter.com                                  PDH Course G293                             www.PDHonline.org 
 

© Lee Layton.   Page 10  of 30 

III. Color 
  
The use of color is important in PowerPoint presentations because it can help convey meaning 
and help influence attitudes.  A well selected color scheme can help the audience understand the 
emotions behind a presentation.  On the other hand, a poor color scheme can make a presentation 
look like a clown act at a circus!  Hopefully the following guidelines will help you convey the 
right message without the use of the clowns.  To understand the use of color we need to first look 
at how colors are defined.   
 
Color Theory 
 
The color circle shown below is commonly called the “color wheel” and is comprised of 12 
colors, or hues.  The 12 colors are known as the primary, secondary, and tertiary colors.  
There are three primary colors: Red, blue, and yellow and they are arranged in a triangle on the 
color wheel.  Combining each of the primary colors will form another color such as red and blue, 
which form the color purple.  Likewise, blue and yellow form green, and yellow and red form 
orange.  These colors: Purple, green, and orange are called secondary colors. 
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The secondary colors can then be used to form additional colors.  For instance, combining the 
primary color, blue, with the secondary color, purple, forms the color pink.  These color 
combinations are called tertiary colors. 
 
The color opposite another color on the wheel, for instance, the colors red and green, are called 
complementary colors.  Likewise, blue and orange are complementary colors. 
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Adjacent colors on the color wheel are called analogous colors.  For the color green, the 
analogous colors are aqua and light green. 
 
The 12 basic colors can be modified by using varying degrees of white and black to create 
hundreds of color combinations.  Adding white to a basic color is called tinting the color.  
Adding black to a basic color is known as shading the color.  Tints lighten colors and shades 
darken colors.  Tinting and shading is referred to as the color values of a color.  Pink is a tint of 
red and brown is a shade of orange. 
 
PowerPoint Color Schemes 
 
PowerPoint has several built-in color schemes.  Most of these schemes have excellent color 
choices.  Look at the following four selections from PowerPoint.  The first uses white text on a 
black background. 
 
The second scheme has a blue background.  The title is in a light blue color and the bullet points 
are in white. 
 

 
 
 
 
 
 
 
 
 
 
 
 

In the next scheme, the background is a blue-green, with yellow for the title and white for the 
bullet points.  The final scheme simply uses black text on a white background.   
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Custom color schemes can be designed in PowerPoint.  The custom color schemes allow the user 
to select a background color, text colors, shadows, accents, fills, and hyperlink colors.  To design 
a custom color scheme in PowerPoint 2003 follow these steps, 
 
Select Format > Slide Design.  In the task panel on the right select Color Scheme and then at 
the bottom of the task panel select Edit Color Scheme.  At this point the user will be given the 
option of editing the color formats.  The colors selected will be the default for all slides in the 
presentation.  The edit options include,  
 
Background.  The background color will be used in both the title block and the text boxes. 
Text and Lines.  Select the color for all text exclusive of the title box text. 
Title Text.  Select the color for the title text. 
Shadows.  This is the color for shadows around text when special formatting is selected. 
Fills.  Fills is the color for Auto shapes as well as other shapes. 
Accent.  Accent is the color for accents. 
Accent and Hyperlink.  This is the color for hyperlink text. 
Accent and Followed Hyperlink.  This is the color for the hyperlink after it has been selected. 
 
Whenever possible try to use the generic PowerPoint color schemes. 
 
Use of Color in PowerPoint 
 
The proper use of color can have a dynamic effect on a PowerPoint presentation.  Be careful 
though that the colors elicit the desired feelings.  Blue and greens imply calmness.  Green can 
mean “go” or “environmentally friendly”.  Red is a passionate color and a danger color (traffic 
stop signs).  Red and yellow are also urgent colors.  Brown is somewhat boring.  The colors 
should also match the topic.  Black implies authority.  Green generates positive feelings and 
stimulates interaction. 
 
A presentation should include no more than four colors, the background color and three other 
colors.  Be consistent with the use of colors in a presentation and use either tints or shades of the 
colors for emphasis. 
 
Cool colors make the best backgrounds.  Generally the right side of the color wheel makes good 
backgrounds.  Warm colors are on the left side of the color wheel.  Once a color is selected – 
either warm or cool – then the color range can be extended by selecting analogous colors.  
Another technique is to select a broader range of a color by varying the tint or shade.  Avoid 
using yellow as a background because large areas of yellow can be irritating to the eye. 
 
Light colored backgrounds can create glare and make it difficult for the audience to see the slide.  
Shades of blue and green are popular background colors.  Avoid “hot” colors such as red, 
orange, and yellow. 
 
One way to provide more contrast between the background color and the text is to use a 
complementary text color.  A light colored text is easier to read on a dark background than on a 
white background.  Complementary colors contrast each other and create a dynamic effect.  
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When used together analogous colors create a harmonious effect and have a tendency to unify 
the slide because they are a creation of the adjoining colors. 
Black text on a white background provides a strong contrast that many find easy to read.  Some 
people find the extreme contrast between a white background and black text distracting.  While 
red and yellow are not good background colors, they are well suited for text.  Yellow text on a 
dark background such as either black or blue is especially effective. 
 
These are some good color combinations, 
 

 

Good Color Choices
 

 

Poor Color Choices 
 

White on Purple Green on Red 
White on Black Red on Yellow 

Yellow on Purple Green on Yellow 
Red on Black Light Green on Green 

Orange on Blue Red on Green 
Light Blue on Blue Yellow on White 

 
The use of color can enhance memory retention.  The Von Restorff Effect, named after Hedwig 
Von Restorff, says that an item that is somehow 
differentiated in a group of similar items will be 
remembered better in both the short term and long 
term than undifferentiated items.  Therefore, using 
color to emphasize an item will aid in memory 
retention.  See the slide on the right. 
 
When using color in graphs the intensity should 
increase as you move to the bottom of the frame 
(darker colors on the bottom and lighter colors are 
you move up the y-axis of the graph.) 
 
Many people have some degree of color blindness, so the colors in a presentation may not have 
the intended benefit.  In some cases it may be difficult for a color blind audience member to 
differentiate between a background and the text.  To minimize problems with color blind 
audience members, it is best to avoid color combinations such as blue-green, red-green, brown-
green, blue-black, and blue-purple.   

Red makes it memorable

Red makes it memorable

Red makes it memorable

Red makes it memorable

Red makes it memorable

Red makes it memorable
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IV. Graphics 
 
Good graphics are a key to a memorable presentation.  Research says that humans encode visual 
and verbal information simultaneously, but using different parts of the brain.  To take full 
advantage of the brains capability we need to provide both visual and verbal stimulus. 
 
In this section we will look at the file formats that are used for PowerPoint graphics, how to 
apply graphs including bar charts, line charts, and pie charts, and the types of images to use in 
PowerPoint presentations.   
 
Graphs 
 
Graphs are useful in presentations for explaining data.  They can be created in PowerPoint or 
imported from Excel.  In most cases it is easier to build a graph in Excel and import it into 
PowerPoint.  Common graphs include Line charts, Bar charts, and Pie charts.  Line charts are 
best used to show data trends.  Bar charts are well suited for high-low comparisons.  Pie charts 
are good for showing percentages of a whole. 
 
Pie Chart 
Look at the next two slides.  The slides present the results of a (fictitious) survey concerning the 
percentage of people who have fallen asleep during a PowerPoint presentation.  The first slide 
shows the results using a bar chart.  The next slide is a better approach where the data is 
presented in a pie chart. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
To further emphasize the “have fallen asleep” answer, see the next slide.  In this example, the pie 
chart is shown in a three-dimensional layout and the chart has been rotated about 30 degrees to 
emphasize the “have fallen asleep” answer. 
 
In either the traditional pie chart view or the 3-D view, the ability to rotate the chart is a useful 
feature to emphasize a key piece of data. 
 
Again, use pie charts to represent percentages. 
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Line Charts 
Line charts are best used to describe data trends.  A good example is the change in the Consumer 
Price Index as compared to the change in salaries during the same time period.  Consider the 
time period from 1980 through 2006.  In the first graph we have the change in the Consumer 
Price Index graphed along with an engineer’s salary for the same time period.  The first graph is 
very difficult to read because of the y-axis gridlines and poor choice of colors.  The second graph 
is easier to read with fewer x and y-axis gridlines and tick marks along with the elimination of 
the individual year reference points. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
Bar Charts 
Discrete data should be represented in bar charts.  Consider the following data about the 
population of a certain State for the years 2005 through 2007.  The point of the data is to 
compare the State’s population variability on a monthly basis.  The first slide shows the data in a 
line chart format.  The second graph has the data in a bar chart format, which shows what the 
presenter wanted to explain – the monthly variability in the State’s population. 
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Use of Images 
 
Research says that a visual presentation is five times more likely to be remembered than a 
presentation using bullet points alone.  A picture is worth a thousand words – if it is the right 
picture!   
 
In the past, clip art was widely used in 
print brochures and other visual media.  
Many PowerPoint presentations also use 
clip art as visuals.  There is really no 
compelling reason to use clip art when 
photographs are so easy to acquire and 
insert into PowerPoint.  The 
accompanying slide has a clip art version 
of a hydroelectric dam and a photograph 
of a hydroelectric dam.  The photograph 
will hold the audience’s attention much 
longer than the clip art.   
 
With the advent of digital cameras it is 
easy to find a suitable photograph for 
most presentations.  There are public domain images available on the Internet as well as many 
lost cost professional images that can be downloaded and inserted into a PowerPoint 
presentation.  The images shown in these examples are from the generic clip art package 
included with PowerPoint.   
 
Images should be used to reinforce the presenter’s point.  For instance, consider the visuals for a 
presentation on how a company is helping the environment by reducing smokestack emissions.  
The first image shown below does not help promote the company’s image as environmentally 
friendly even though it is certainly relevant to smokestack emission. 
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The second image (shown above) is a much more positive visual image for the company’s 
environmental stewardship program. 
 
A mistake that is sometimes seen in PowerPoint presentations is the use of a visual image that is 
not relevant to the subject matter.  See the two images below where the presentation is about 
traffic congestion in metro Atlanta.   

 
The slide on the left is a good visual when discussing traffic congestion.  The slide on the right 
might seem like a good visual for a bottleneck, but it is not a good visual for traffic congestion.  
You might say that the same complaint could be made about the previous example about 
environmental stewardship where leaves where shown instead of a smokestack.  However, in the 
previous example the subject was about smokestack emissions and not smokestacks, so a “green” 
image is appropriate. 
 
Graphic File Formats 
 
There are several types of graphical file formats including BMP, JPEG, GIF, TIFF, and PNG.  
The file formats differ in file size, compression, and color types.  Some of the types are better 
suited for photographs and others are better suited for text and drawings.  Let’s look at a few of 
the common graphic file formats and their applications. 
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BMP 
Bitmap, BMP, is the standard Microsoft Windows file format.  Bitmaps tend to be rather large 
files.  A BMP file has a 24-bit bitmap image and is the standard format for PC Paintbrush.  It has 
a fixed palette of colors that may not transfer correctly to other formats.  BMP is known as a 
lossless format because the image is not degraded due to compression.  BMP is an older format 
and somewhat archaic compared to the newer formats available, but is still good for PowerPoint 
backgrounds and graphics.  BMP is not the best choice for photographs because of its limited 
color palette. 
 
JPEG 
The Joint Photographic Experts Group, JPEG, format uses 
compression to minimize the size of the file.  JPEG is a 
“lossy” format so every time the image is saved some image 
quality is lost.  JPEG supports 24-bit color and is a good 
choice for photographs.  Because of the lossy nature of a 
JPEG it is not a good choice for text and graphics where sharp 
lines are present.  The lossy format leaves artifacts on the 
image such as in the graphic shown on the right. 
 
GIF 
Like JPEG, the Graphics Interchange Format, GIF, is a lossy 
format because of compression.  GIF files are not as small as 
JPEG’s, but they still offer reasonable compression and small file sizes.  GIF’s do not lose image 
quality every time the file is saved.  They are limited to 8-bit color though, so GIF’s are not a 
good choice for photographs.  GIF’s are best suited for text, graphics, and drawings. 
 
TIFF 
The Tagged Image File Format, TIFF, is complex file format with a large file size.  It supports 
many file formats including 8-bit images as well as 24-bit images.  It has a lossless compression 
format.  TIFF is commonly used for high quality printing and is not generally used for 
PowerPoint images. 
 
PNG 
One of the newer file formats is the Portable Network Graphics, PNG, which uses a lossless 
compression technology.  It supports 24-bit and 48-bit color and the compression is better than 
GIF files.  PNG is good replacement for both the GIF and the JPEG file format.  PNG is 
relatively new and is not readable by some of the older programs and web browsers.  PNG does 
not leave JPG type artifacts. 
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V. Animation 
 
PowerPoint has some very good animations features – most of which should not be used.  Many 
of the animation features used by presenters are gimmicky and tend to distract from the 
presentation instead of enhancing the presentation.  There are a few animation features worth 
mentioning though.  In this section we will look at PowerPoint animation schemes, custom 
animations, transitions, and action buttons.  We’ll start with the most widely misused feature – 
transitions. 
 
Transitions  
 
There is very little reason to ever use transitions.  They come across as gimmicks and either 
distract or aggravate the audience.  If you have sat through many presentations you have 
probably seen transitions in use.  Transitions allow the 
presenter to “fly” text onto the screen from the left, right, up, 
and down, as well as other special effects.  There are very few 
reasons where a transition enhances a presentation. 
 
One transition that can be used effectively is called the 
“newsflash”.  This transition spins an object onto the screen 
like newspaper news flashes were spun onto the screen in old 
movies.  Since this is a somewhat accepted presentation style 
in can be used effectively to emphasize a point.  The “newsflash” transition is added by selecting 
Slide Show -> Transitions -> Newsflash. 
 
Animation schemes  
 
Animation schemes include features such as “appear”, “highlights”, “dissolves”, “fades”, etc.  
“Appear” is commonly used in presentations to allow one item to appear on the screen at a time.  
This allows the presenter to discuss each item without allowing the remaining items to distract 
the audience.  In practice, “appear” schemes may actually be distracting since the audience will 
be wondering what’s next.  A better approach is to use the “highlights” animation scheme. 
 

 
 
 
 
 
 
 
 
 
 
 
 

“Newsflash” Feature“Newsflash” Feature

Highlight Feature

• This is point number one

• This is point number two

• This is point number three

Highlight Feature

• This is point number one

• This is point number two

• This is point number three

Appear Feature

• This is point number one

Appear Feature

• This is point number one
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With the “highlights” feature, all of the bullet points appear on the screen at once, but only the 
bullet point being discussed is highlighted.  As the presenter ‘clicks’ on a point, the previous 
point becomes lighter and the point under discussion is highlighted.  This approach allows the 
audience to see all bullet points and allows the presenter to emphasize the point under discussion. 
 
The “highlight” feature is activated by selecting Slide Show > Animation Schemes > 
Highlights. 
 
Custom Animations 
 
The custom animation feature of PowerPoint can be used to replicate what is known as the “Ken 
Burns Effect”.  Ken Burns is the director of several well known documentaries such as The Civil 
War and Baseball.  Ken Burns used slow panning and zooming effects to bring still photographs 
to life.  This feature can be replicated in PowerPoint using custom animations to pan and zoom in 
on a particular item in a photograph.  The effect gives the appearance of motion to a still 
photograph, which can hold the audience’s attention.  This feature is accomplished in 
PowerPoint by using the custom animation features of grow/shrink command and the motion 
path commands. 
 
To create the effect a photograph is first loaded into a slide in PowerPoint.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next, select Slide Show > Custom Animation > Add Effect > Emphasis > Grow/Shrink.  
Then set the degree of growing (or shrinking.)  A good ‘grow’ setting is 150%.  The speed of the 
animation should be set to ‘very slow’.  The effect can be tested by pressing the Play button.  
This animation gives the appearance of zooming in to a spot on the image.   
 
The next step is to create a lateral motion path.  To do this select, 
Slide Show > Custom Animation > Add Effect > Motion Paths > Line 
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Then, place the cursor at the desired starting and ending points on the photograph (this is a little 
tricky to get just right and may take some adjusting.)  The program will place line with the 
beginning and ending points.  The speed should be set to ‘very slow’.  Test the effect by pressing 
the Play button. 
 
Finally, the two animations need to be integrated.  To combine the animations, select the second 
animation and then select > Start with Previous.  Now the animations should move seamlessly 
by zooming in and moving laterally to the desired location on the photograph. 
 
It takes a little ‘tinkering’ to get just the right effect, but the effort is worth it. 
 
Action Buttons  
 
Another useful animation feature is known as “action buttons”.  Action Buttons are essentially 
hyperlinks to other parts of a presentation.  This will make the presentation appear more 
interactive and can be used to allow the audience to participate in the direction the presentation 
takes.  For example, a Human Resources manager may need to give a presentation to an 
employee group about employee benefits.  The typical presentation might begin like the slide 
shown on the left below.  In this slide are four bullet points with the key items the HR director 
plans to cover.  The remaining presentation would then cover these items in detail. 
 
A better approach for this type of presentation might include using Action Buttons as shown in 
the slide on the right below. 

 
The action buttons are actually hyperlinks to specific slides in the presentation.  Using actions 
buttons will allow the HR director move through the presentation in the order that the 
employee’s prefer as opposed to a fixed presentation.  Action buttons are found under the “Slide 
Show” menu and are easy to setup so the process will not be described here. 
 
 

Employee Benefits
• Medical
• Vacation
• Sick Leave
• Retirement

Employee Benefits
• Medical
• Vacation
• Sick Leave
• Retirement

Employee Benefits

Medical Vacation

Sick Leave Retirement

Employee Benefits

Medical Vacation

Sick Leave Retirement
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VI. Slide Layout 
 
Basically a PowerPoint presentation will consist of text, tables, charts, and images.  The goal is 
to integrate these features to make a seamless, coherent, attention getting, presentation.  The use 
of bullet points, numbered points, and how text and images are presented are critical to the 
success of a presentation.  In this section we will look at bullet points and slide readability. 
 
Bullet Points  
 
Bullet points are what you might call the “backbone” of a PowerPoint presentation since they are 
found in virtually every PowerPoint presentation given.  Invariably you will need to use bullet 
points in a presentation.  These guidelines will help you use bullet points to your advantage. 
 

1. Only use bullet points when necessary.  Is there another way to present the information 
without a bullet point?  A photograph or image perhaps? 

 
2. Bullet points should not be used as an outline of the presentation.  The bullet points 

should convey specific information (e.g. “Sales are up 12%”, instead of “Sales results”.) 
 
3. Bullet points should not be a ‘laundry list’ of things 

you need to do in your presentation.  The slide on 
the right is an example of a ‘Laundry list’ bullet 
point presentation.  Laundry list type items should 
be on the speakers notes of items to cover, but 
should not be listed on a slide.  Another example of 
“laundry list” bullets is one word bullets.  One word 
bullets look like a grocery list such as “milk, bread, 
eggs, etc.” 

 
4. In some cases, numbered items should be substituted for bullet points.  A numbered list 

should primarily be used when a sequence is being explained, such as the steps necessary 
to perform a task.  For instance, the steps necessary to change the oil in your car should 
be listed as a numbered list.  Items to check during routine car maintenance should 
probably be listed in bullet point form.  An exception is if you are trying to emphasize a 
plan such as “12-Point Maintenance Plan”. 

 
5. Use action buttons when possible.  Even if the buttons are not hyperlinked for 

interactivity, the buttons will give the presentation a better look. 
 
 
 
 
 
 
 
 

“Laundry Lists”

• Introduce Executive Vice President
• Explain purpose of presentation
• Introduce new product
• Explain benefits of new product
• Ask for Questions

“Laundry Lists”

• Introduce Executive Vice President
• Explain purpose of presentation
• Introduce new product
• Explain benefits of new product
• Ask for Questions
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Slide Titles 
 
Slide titles should be descriptive of the content of the slide.  Too often the title of a slide looks 
like a heading out of an outline or the title of a chapter in a book.  For instance, a title of a slide 
reporting the financial results could say, 
  

.  Financial Results FY2006   .              
 
But a better heading might be, 
 

.   Net Income up in 2006   .   
 
The point is to make the title descriptive of the slide’s contents and create interest for the 
audience.  In the case shown above, the second title emphasizes the financial results of the 
company by saying the net income is up in 2006 instead or the somewhat boring former slide 
that just says “Financial Results FY2006”. 
 
666-Rule 
 
While the number is 666 is considered by some to have satanic connotations, it is a good rule to 
prevent hellish presentations!  The purpose of the 666-rule is to help the presenter to remember 
to limit each slide to no more than about six bullet points and to limit each bullet point to no 
more than six words.  Furthermore, a presentation should not be longer than about six slides 
without some type of visual for the audience.  Remember, 
 

1. No more than six bullet points to a slide. 
2. No more than six words per bullet. 
3. No more than six slides without. 

 
Applying the 666-Rule can help to keep presentations readable and interesting. 
 
Readability 
 
A common problem in PowerPoint presentations is graphics and tables that are virtually 
unreadable by the audience.  If a table or chart is used in a presentation, the numbers must be 
readable from every seat in the audience.  If they are not, the presentation should be adjusted to 
make the presentation readable.  Simplifying tables and using callouts are effect means to make 
presentations more readable. 
 
Simplify Tables and Charts 
In the example shown below, the monthly population is shown for a State for the years 2005 
through 2007.  The table on the left shows the exact population, which results in an 8-digit 
number – and a mass of digits. 
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Contrast the slide on the left with the slide on the right where the State population is shown in 
millions.  In this form the population values are 3-digit numbers making the slide much cleaner 
and easier to read without any significant loss in accuracy. 
 
I know you can’t read this but… 
In a presentation, anytime you hear 
someone say “I know you can’t read 
this but…” then there is something 
wrong with the presentation.  The slide 
shown on the right is the balance sheet 
for a company.  The presenter is trying 
to call attention to the total assets of 
the company, which is nearly 
impossible to read on this slide. 
 
An option is to use callouts to call 
attention to a specific piece of 
information.  The slide below is the 
same balance sheet as shown in the 
slide above, but the total assets column 

has been expanded to make the actual 
numbers readable.  A callout allows the 
presenter to give the audience the ‘feel’ of 
the actual document (you can basically 
tell where the total assets are found on the 
balance sheet) while also allowing the 
audience to read the actual values. 
 
 
 
 
 
 

15,415,841 15,442,338 15,145,087 December
15,493,307 15,519,938 15,221,192 November
15,339,908 15,366,275 15,070,488 October
15,188,028 15,289,826 15,055,432 September
15,037,651 15,274,552 14,980,530 August
15,266,651 15,507,159 15,208,659 July
15,420,860 15,353,623 15,362,282 June
15,735,571 15,201,607 15,061,061 May
15,579,773 15,433,103 14,838,484 April
15,737,145 15,280,300 14,988,367 March
15,705,733 15,249,801 14,694,478 February
15,550,231 15,234,566 14,548,988 January

200720062005Month
State Population
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15,266,651 15,507,159 15,208,659 July
15,420,860 15,353,623 15,362,282 June
15,735,571 15,201,607 15,061,061 May
15,579,773 15,433,103 14,838,484 April
15,737,145 15,280,300 14,988,367 March
15,705,733 15,249,801 14,694,478 February
15,550,231 15,234,566 14,548,988 January

200720062005Month
State Population

15.415.415.1December

15.515.515.2November

15.315.415.1October

15.215.315.1September

15.015.315.0August

15.315.515.2July

15.415.415.4June

15.715.215.1May

15.615.414.8April

15.715.315.0March

15.715.214.7February

15.615.214.5January

200720062005Month

State Population
(millions)

15.415.415.1December

15.515.515.2November

15.315.415.1October

15.215.315.1September

15.015.315.0August

15.315.515.2July

15.415.415.4June

15.715.215.1May

15.615.414.8April

15.715.315.0March

15.715.214.7February

15.615.214.5January

200720062005Month

State Population
(millions)
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Fresh Fish 
There is a classic story told in journalism school about eliminating unneeded words in a story.  
The example given is about a fish merchant in a busy seaside fishing village.  The merchants’ 
store has a sign above the store that says “Fresh Fish Sold Here”.  The journalism professor asks 
his class what one word is unnecessary in the store’s sign.  The students say the merchant could 
eliminate the word “Here”.  After all, where else would the fish be sold?  The professor then 
says, “Now that ‘Here’ is gone, are there any other words you can eliminate?”  After a brief 
period of reflection, the students answer “you might eliminate ‘Sold’ since the purpose of the 
store is to sell fish.”  The professor then says “What about the word ‘Fresh’?  What other kind of 
fish would a seaside merchant in a fishing village sell?”  “So”, the students responded, “the sign 
should just say ‘Fish’?”  “Not at all”, says the professor.  “The word ‘Fish’ is unnecessary too.  
The merchant should just hang a plaque of a 
fish above his store!”   
 
The point of this story is to eliminate as many 
words as possible and to use visuals in 
presentations whenever possible.  The visuals 
may be photographs, images, tables, charts, 
graphs, etc.  This makes the presentation 
cleaner and easier to comprehend.   
 
Consider the following two slides.  The slide 
on the left is a textual report of the financial 
condition of a company.  A PowerPoint slide should almost never have a paragraph of text unless 
it is a direct quote needed for emphasis or historical accuracy (e.g. the preamble to the 
Constitution of the United States would of course be shown in its complete form.) 
 

 
In this case, a better approach is to give the highlights in the PowerPoint slide and the presenter 
should then expound on the results as necessary.  The slide on the right is a brief synopsis of the 
company’s financial results without the wordiness of the slide on the left.  From the slide on the 
right, the audience can tell at a glance that the company had improved sales in 2007, but had a 

Financial Results

For 2007 sales were up 8% compared to the 
disappointing sales in 2006, where sales 
were virtually flat.  Operating expenses 
increased 12% in 2007 as compared to 
the slight decrease of 3% that occurred in 
2006.  The resulting net income for 2007 
was therefore down 5%, compared to the 
2006 net income, which was up 10%.

Financial Results

For 2007 sales were up 8% compared to the 
disappointing sales in 2006, where sales 
were virtually flat.  Operating expenses 
increased 12% in 2007 as compared to 
the slight decrease of 3% that occurred in 
2006.  The resulting net income for 2007 
was therefore down 5%, compared to the 
2006 net income, which was up 10%.

Financial Results
2007

Sales 8%

Expenses   12%

Net income  5%

2006
Sales 0%

Expenses     3%

Net income 10%

Financial Results
2007

Sales 8%

Expenses   12%

Net income  5%

2006
Sales 0%

Expenses     3%

Net income 10%
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reduction in net income because of rising expenses.  It is also easy to see that in the prior year 
sales were flat, but the company controlled expenses better and had a positive net income. 
 
VIII. Presentation Tips 
  
This section has a few tips on how to prepare for the actual presentation.  This includes having 
the projector set up and working correctly with the presentation, preparing for the unexpected, 
and having an abbreviated presentation ready. 
 
Projector Woes 
 
One of the biggest fears when using PowerPoint is a connectivity problem between the computer 
and video projector: And rightfully so, because many times connectivity is the weak link in 
getting a presentation onto the screen.  While every computer/projector combination may be 
different, here are some basic guidelines that may help allay these fears. 
 
The first step should be to make a connection between the projector and the computer with both 
devices turned off.  After the devices are connected, turn the projector on first.  Then turn on the 
computer.  As the computer boots up it will send a signal through the cable to the projector to 
negotiate the display settings.  Many projectors have an “A” input and a “B” input.  You may 
have to cycle the projector through its settings to get the image to display on the projector.   
 
The display function on the computer keyboard may have to be toggled 
to make a signal connection with the projector.  The key strokes will 
differ depending on the computer, but it will be similar to the function 
key “FN” and “F8”.  Both keys must be pressed simultaneously.  The 
correct function number usually has a display image on the key or it may 
say “CRT/LCD”, etc.  Be careful to not continually press the function 
keys trying to get the connection to work – this may cause the computer 
to cycle through the options.  Instead, press the function keys and give the computer a second or 
two to sort out the connection. 
 
Here are a few other computer tips, 
 

1. Make sure the computer power settings are set to “always on”. 
2. Ensure that a laptop is running on AC power and not the battery. 
3. Turn off screen savers. 
4. Turn off programmed functions such as virus scans, etc. 
5. Make sure all other applications are turned off. 

 
And finally, remember to not panic.  No matter what you do, some days a computer-projector 
connection is just not going to work! 
 
The Blank Screen 
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A neat feature of PowerPoint is the ability to quickly blank the presentation from the audience’s 
view using either the “W” or “B” key during a presentation.  You should always have your 
presentation set up and running with the projector prior to the actual presentation.  The problem 
is that at some meetings, such as a civic organization there will usually be a dinner or other 
activities before your presentation.  You do not want your presentation projected during these 
activities.  To avoid this problem, set up the show and then press the “B” key on the keyboard.  
The PowerPoint presentation will go blank, but will still be running.  Pressing “B” again will 
return to the presentation. 
 
This feature is useful during the presentation too.  If there is a pause for questions, or if the 
presenter wants the audience to focus on what he is saying, he can press the “W” button for a 
blank white screen, or the “B” for a blank black screen, which will force the audience to direct 
their attention to the presenter.  When the presenter has made his point pressing the appropriate 
button again will resume the presentation. 
 
Company Logo 
 
Many companies have a master template with their logo in the corner of every slide.  The 
presenter’s company logo should be shown in a beginning and ending slide.  However, it should 
not be on every slide in the presentation.  A logo on every slide is distracting to the audience. 
 
Another item to consider is at the end of the presentation, after the final company logo slide, 
there should be one or two blank slides.  Otherwise, if the presenter clicks past the logo slide, the 
PowerPoint “back room” will be shown.  It will look more professional for the presentation to 
remain in the slide show form. 
 
“We’re about out of time…” 
 
Anyone who has given a presentation with a panel of others speakers has probably experienced 
the “we’re about out of time announcement” just prior to giving their presentation.  The result 
can result in a fast rush through the slides to finish the presentation before the allotted time is up.  
Anything faster than about 30 seconds per slide is going to make the audience anxious and will 
certainly distract from the presentation.  There are two approaches to deal with the abbreviated 
time. 
 
One approach is to know your slide numbers and be able to jump to specific key slides.  A 
feature of PowerPoint is the ability to key in any slide number during a presentation and, by 
pressing ENTER, jump right to that slide.  Know where your key slides are and just jump to the 
most important slides. 
 
A more refined approach to the time problem is to have an alternative presentation ready to 
deliver.  This is easy with PowerPoint by using the Custom Shows feature.  To access the custom 
shows, first open the presentation in PowerPoint and then go to Slide Show > Custom Shows > 
New.  At this point all of the slides in the presentation will be listed.  Just click on the key slides 
to include in the custom show.  Now when the need arises just select the custom show and give 
an abbreviated presentation. 
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“In conclusion…” 
 
The conclusion is probably the most important component of any presentation.  Unfortunately 
many presenters waste this opportunity to summarize their key points and make a lasting 
impression.  Something like the slide on the left is a common ending for a PowerPoint 
presentation or the presenter may use a giant question mark as the ending to his presentation.  
Instead, use the last slide to call the audience to action or to reinforce the message of the 
presentation.  The slide on the right is meant to encourage the audience to act about a Federal 
government funding proposal.  It is much more effective than a horse’s posterior.  
 

 
 
 
 
 
 
 
 
 
 
 
 

 
The closing of a presentation doesn’t have to be a slide either.  The best closing may be to turn 
off the PowerPoint (use the “B” key) and tell the audience a story, give a quote, or do something 
to make the presentation memorable for the audience.

The EndThe End Before you sleep tonight…

• Call your county commissioner
• Write your congressman
• Tell a co-worker

Before you sleep tonight…

• Call your county commissioner
• Write your congressman
• Tell a co-worker
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Summary 

 
In this course, we have reviewed a few of the common problems found in PowerPoint 
presentations and how to avoid problem presentations.  We also looked at many of the rich 
features of the PowerPoint program that can be used to aid in making quality presentations. 
 
The suggestions presented in this course are based on years of experience in making PowerPoint 
presentations.  By using color wisely, developing clean visuals, and using text appropriately a 
speaker can develop effective – and stunning – presentations. 
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